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Montana Memory Project 

 

I. Introductory Information 

A. CONTENTdm VOCABULARY 

 

Administration: CONTENTdm online interface for uploading edited files from the 

Project Client to the Montana Memory Project web site 

 

Compound object: Multiple images files that are displayed to the end user as a single 

object (e.g. books, pamphlets, newspapers, and photo albums)  

 

CONTENTdm: a windows-based, digital collection builder where data and digital items 

are prepared in large batches via the CONTENTdm Project Client and then uploaded 

to a CONTENTdm server 

 

Digital collection: the items grouped by provenance or theme as proposed by 

contributors in the MMP Collection Application.  All MMP digital collections are at 

http://mtmemory.org/  

 

Import: when items are entered from a local computer into the Project Client 

 

Item: A file and its associated metadata  

 

Object: An item or a group of items that collectively represent a single work  

 

OCR license: An OCR license, or Optical Character Recognition License, is used to 

convert a digitized image of text into a searchable text file. If you have text-based 

items (pamphlets, books, reports, etc.), please contact Katie Beall at kbeall@mt.gov 

to reserve an OCR license before entering items into the Project Client. 

 

Project: the temporary interface used to save work in the Project Client while 

importing images and editing metadata for a collection  

 

Project Client: Downloaded CONTENTdm software where data and digital items can 

be prepared in large batches 

 

Upload for approval: the final step to be completed in the Project Client. Once a 

project’s images and metadata have been imported and edited in a project, the items 

will be uploaded for approval. Once uploaded, the items are added to the pending 

queue in CONTENTdm Administration to be approved and indexed to the Montana 

Memory Project web site 
 

  

http://mtmemory.org/
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I. Introductory Information 
B. Download the Project Client Software 

 

CONTENTdm’s Project Client software is what MMP contributors use to prepare data and 

digital items in large batches.  The downloadable installation file for Project Client is located 

at the ContentDM User Support Center (USC). You will need an account at the USC in order 

to create or update Project Client and get access to OCLC documentation. All MMP 

contributors should create an account at the USC.  

 

Note: This procedure assumes you are downloading to a Windows computer. 

 

1. Go to http://contentdm.org/USC 

2. If this is your first time at this site, you will need to register under Register Now. 

Contact the MMP technical support at mmp@mt.gov for the Organization ID. For your 

username, enter your email address. For password, create your own password. 

3. Once you are logged in, click Downloads on the top right of the page. 

4. On the CONTENTdm Downloads page, under Other Downloads, click the link Project 

Client. 

5. On the next page, right-click on the link called InstallProjectClient612.zip. In the pop-

up menu, click Save Target As/Save Link As.  

6. In the Save As window, choose a location (the easiest is to your Desktop) and click 

the Save button. Wait for the download to complete. 

7. Locate the file InstallProjectClient icon on your computer and double-click to unzip it.  

8. You should see an icon called Install Project Client. Double-click it. 

9. Choose Run if a message about the publisher being unverified opens. If asked about 

installing required or recommended tools, choose Yes.  

10. After installation is complete, you will see an Install Complete message. Close that 

message.  

11. Locate the CONTENTdm Project Client icon on your desktop and double-click it. 

 

You may be asked for the following: 

 User name 

You were given this by the Montana State Library. It’s a string of numbers and letters 

like cdm/103401user85 

 Organization name 

Type the name of your library or museum.  

 Serial number 

C92E8-39MPC-ZRY9U-EYE22 

 Password 

You were given this by the Montana State Library. It is a string like Yeg80Xeb. 

 

 

 

 

 

 

http://contentdm.org/USC
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I. Introductory Information 

C. Project Client Workflow  

 

 Preparatory steps to complete before working in the Project Client:  

 

 Documents for the collection have been digitized and saved and named as 

digital files according to MMP recommendations  

 Reserve an OCR license if necessary (Contact mmp@mt.gov to reserve a 

license) 

 Contact the Montana State Library for CONTENTdm software training 

 Download the Project Client 

 

Steps to complete within the Project Client:  

 

1. Open the Project Client 

2. Create a new project or open an existing project in the home screen 

3. Set up the project’s settings in the Project Settings Template(s) 

a. If necessary, activate an OCR license (The license will only be 

applied to items added after the license’s activation)  

b. Set up the project’s metadata template(s) 

4. Import items into the Project Client 

5. Add and edit metadata  

6. Upload Items for approval in CONTENTdm Administration 

 

 

 

 
 

 

 

 

 

 

 

Contact 

Administrato

r to approve. 

mailto:mmp@mt.gov
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I. Introductory Information 

D. Navigate the Project Client: The Home Screen 

 

The Home Screen 

 

 
Figure 1. Project Client home screen 

 

Just like with learning any piece of new technology (e.g. a cell phone, iPod, etc.) or software, 

take the time to explore the Project Client and look around. The home screen of the Project 

Client does present a lot of information but each option is presented in multiple ways. This is 

signified in Figure 2 by pairing repetitive options by color.  

 

 

 
       Figure 2. Repeated elements on the home screen are shown by common colors 
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I. Introductory Information 

D. Navigate the Project Client: The Project Screen 

 

The Project Screen: see the open project information and perform the project tasks of 

importing items and editing metadata 

 

New project screen: 

   
Figure 3. The project tab is highlighted in red; the home tab is shown in green 

 

Active project screen:  

 
Figure 4. Items have been already imported (see under thumbnail tab) and metadata 

has begun to be added to the project spreadsheet. 
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II. Create and Manage a Project 

A. Create a New Project  

 

Note: To create a second (or third, etc.) project, follow steps 2-7. 

 

1. Double click the CONTENTdm Project Client icon on your desktop 

2. On the home screen, click Create a new project (See Figure 5) 

3. Enter in the Server URL https://server16013.contentdm.oclc.org 

4. Enter in your user name and password (sent to you by the Montana State Library) 

 (Your username will be similar to CDM\104305user80 and your password will 

be a string such as  

   Jub34Xat.) 

5. Link the project to a collection—be certain to select the correct collection 

6. Choose a project name (this name will only be used in the Project Client and once 

your project is uploaded for approval, the project name will no longer be 

associated with imported and uploaded  items) 

 

 
Figure 5. How to create a new project in the home screen: First, choose one of the three 

“Create Project” tabs (shown in red). Then, enter in your username (e.g. 

CDM\105201user29) and password (e.g. Boz79Kip). Select your collection, and choose a 

project name. Decide whether or not to share the created project 

II. Create and Manage a Project 

B. Open and Delete a Project 
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Figure 6. Once a project is created, the home screen will show current project information. In 

this guide, the project name is “School photographs” and the collection is titled “Test 

Collection” 

 

Open an Existing Project  

 

1. From the Project drop-down menu, choose Open (See Figure 7) 

2. Highlight the correct MMP Collection and Project Name and click Open 

  

Delete a Project 

 

1. From the Project drop-down menu, choose Delete (See Figure 7) 

2. If you want to delete a project that is currently open, Close it first and return to 

the home screen. Go back into the Project drop-down menu, choose Delete, and 

highlight your MMP Collection and Project Name and click delete 

  

 
 

 

 

 

 

Figure 7: Go to the upper Project drop-down menu for more 
project options such as create new, open, close, delete, or 
edit a project. 
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III. Set up Project Settings  

 

By using the Project Settings Manger in the Project Client, there is a way to save specific 

settings in a template that are applied to each project. This is an efficient way to avoid 

having to enter repetitive metadata for imported items. Also, OCR licenses are activated at 

this same time (before items are imported so that a text transcript is created). Templates 

are set and OCR licenses are activated in the Project Settings Manager.  

 

Choose one of the three ways to set up the Project Settings Manager (indicated by red boxes 

in Figure 8):  

 From the Project drop-down menu, select Project Settings Manager and then select 

the necessary page  

 From the Project Client Home tab, click Edit Project Settings 

 Under Other Tasks, select Edit Project Settings 

 

 
 Figure 8. How to open up the Project Settings Manager 

 

This guide focuses on the Metadata Templates, OCR, and General Settings options in the 

Project Settings Manager. MMP Contributors should be familiar with these tabs. Metadata 

Field Types, Images and Thumbnails, Processing, Project Options, and Find in Collection are 

not necessary for MMP contribution.  Information about these tabs will not be covered in this 

guide but is available at the OCLC user support site.  

 

 General Settings: provides basic project and basic collection information 

 Metadata Templates: set up project template(s); enables contributor to select and 

customize metadata templates to help create consistency and expedite your 

cataloging process. Templates are available for the general project (all item types), or 

for specific item and object types, as well as for specific image file types. 

 OCR: activate an OCR license to create text transcripts 
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III. Set up Project Settings 

A. Define Project Template(s)  

 

Create a project template to allow shared settings and metadata to be applied to each item 

imported into the Project Client. There are two main ways to set up a project template: 

 Use the general template to set a metadata template that will apply to all items 

imported after the template is set 

 Use a combination of the file type-specific templates (not just the general template) 

for a collection with differing metadata values  

 

Set shared metadata settings by using only the general template:  

 

Create a general template that will apply to every item in the project. This means that all 

TIFFs, audio files, and compound objects, etc., could have all their shared metadata entered 

into the general template and this metadata would apply to every item thereafter imported. 

 

1. Open the Project Settings Manager from the open Project Screen or home screen 

(See Figure 8) 

2. Make sure Metadata Templates is highlighted in the left column 

3. Click Edit next to Project Settings (general) (See Figure9) 

4. Enter any constant metadata by typing opposite the appropriate metadata field 

value in the blank Default Value column 

5. If you are using multiple types of file formats (TIFFs, JPEGs, PDFs), a contributor 

can set the metadata to be repeated for a specific file format as long as, for 

example, all TIFF files have the same constant metadata fields. Any templates 

that are not the general template will override the general template. For example, 

a contributor can create a general template and still have one template that is 

unique for TIFF files that is different from the general template. 

 

 
Figure 9. How to select the general template. In the example, the shared metadata fields 

are: type, contributed by, geographic range, language, and the date digitized. Select Ok to 

save the template 

III. Set up Project Settings 
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A. Define Project Template(s)  

 

Set shared metadata settings by using a combination of templates 

 

Option 1: The first option is to use the general template only, but to set and reset it multiple 

times by importing in batches items that have shared metadata. To do so, set the general 

template to reflect the first batches’ metadata and import the items. Then, before importing 

a second batch of items whose metadata differs from the first batch, change the template to 

reflect the second batches’ metadata. Then, import the second batch of items. Repeat this 

process as necessary, remembering to update the general template for the batch of items 

that will be imported next. 

 

Option 2: The second option is to create a template for each set of items that have differing 

metadata based on their file format. This option would be a good choice if a collection had, 

for example, a set of photographs (TIFF file) and a collection of digital oral histories (audio 

file) and both file types (TIFF and audio) had unique metadata. Both of these file formats 

(TIFF and audio) could have their own template. The photographs’ metadata would be 

entered in the TIFF template. Then, the oral histories metadata would be entered in the 

audio template. All imported TIFF files would have the metadata in the TIFF template 

automatically entered upon import. All the audio files would have the metadata in the audio 

template automatically entered upon import. (See Figure 10) 

 

 
Figure 10: As described in Option 2, the TIFF option was checked, and then its 

corresponding edit button selected. Metadata was then entered specifically for TIFF files. 

The same steps were then repeated with the Audio Template. 
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III. Set up Project Settings 

A. Define Project Template(s)  

 
Figure 11: In the example, metadata that is unique to all TIFF files to be imported has been 

entered and is emphasized by red boxes 

 

To set multiple templates, check the box next to the appropriate file format to have a 

template created. Then, select Edit. The file-specific template will open. Enter in all the 

shared metadata values for the type of file and select Okay. Repeat this as needed for other 

file-type metadata templates. Select Ok in the overall Metadata Templates display when 

finished.  

 

Note: Any other templates (images, compound objects, audio, etc.) that are created would 

supersede the general template.  For example, if a general and image template were 

created, all items would have the same metadata automatically entered that was saved in 

the general template with the exception of the metadata entered in the image template, 

which would be entered for all imported items.  

 

Once the metadata templates have been set in the Project Settings Manager, the OCR 

license (if applicable) will be activated. 
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III. Set up Project Settings 

B. Activate OCR License 

 

Any collection that has text documents (e.g. newspapers, pamphlets, books) should use an 

OCR license to create a searchable text transcript. OCR licenses are available for reservation 

by contacting the MMP technical support at mmp@mt.gov . Also, OCR licenses must be 

activated before text-based digital files are imported. 

 

1. To activate an OCR license, open the Project Settings Manager (see Figure 8) 

2. Select the OCR tab in the column and Activate (see Figure 12) 

 

 
                  Figure 12. Activate an OCR license 

3. Enter in the OCR license when prompted for a serial number (e.g. FEPA-9389-

8484-1839. The OCR license and serial number are the same string of letters 

and numbers) 

4. The Project Client must be restarted now in order to active your ORC license 

5. When the Project Client is reopened, change the settings so an OCR transcript is 

created. To do so, go to: Project Settings Manager and then Metadata Templates. 

Select edit next to the appropriate template, and under the field of transcript, 

change the default value from Text to OCR (see Figure 13 below). Select Ok.  

 

 
Figure 13. Setting the template to create an OCR transcript 

 

 

 

 

mailto:mmp@mt.gov
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IV. Import Items 

 

To import an item from your local computer into the Project Client, select the type of item to 

upload either under the Add drop-down menu on the upper tool bar or under Common Tasks 

(shown with boxes in Figure 14). 

  

To add items efficiently into the Project Client, decide if the 

item is a single item (such as a single photo, a single page, 

or one map), multiple items (e.g. photographs, maps) or a 

compound object (an item composed of multiple pages 

with or without hierarchy). Items are added into the Project 

Client based on whether they are single, multiple or 

compound objects. 

 

 

 

Figure 14. How to select to import items  

 

 

A. Compound Objects  

 

If your folder hierarchy was set up as recommended by the MMP (see page 3) each 

document should have been saved as a compound object. Now  

 

Compound objects can be classified as the following:  

 Documents (best for objects with multiple sequential pages such as a report, journal, 

photo album, or related image sets) 

 Monographs (allows the hierarchical structure of documents, including sections, 

chapters, and pages to be retained)  

 Picture cubes (enables a selection of up to six images to link together, such as 

multiple views of a three-dimensional object) or  

 Postcards (holds both the front and back images of two-sided items, such as tickets, 

flyers, and baseball cards). 

  

Contributors will also need to determine if an item is a compound object with hierarchy or 

without hierarchy. A document with hierarchy has an internal structure of organization. For 

example, chapters, volumes, or divisions by years would be hierarchical. A collection of maps 

or photographs with no internal organization would be compound objects without hierarchy.  

It is recommended to choose “compound object without hierarchy” if page order is the only 

hierarchy.  

 

As explained in on page 3 (Create a Folder Hierarchy), A compound object must be saved in 

its own folder with one compound object per folder. For example, if there was a compound 

object  
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IV. Import Items 

A. Compound Objects  

 

of a six-sided pamphlet, each of the six items (six sides = six scans) would be stored in the 

same folder without any unrelated items in the same folder.  

 

To import a compound object: 

 

1. From the open Project Screen, choose Add Compound Objects (see Figure 14) 

2. Click Add next to the default value of Compound Object Wizard (See Figure 15) 

 

 
                Figure 15. The Compound Object Wizard. Select Add to import compound objects 

 

3. Select Document. Document with no Hierarchy or Monograph. Document with 

hierarchy (See Figure 16) 

4. Under “Are the compound object and metadata defined by a tab-delimited text file?” 

select No then Next (See Figure 16) 

 

 
  Figure 16. Choose what type of compound object to create. Then, select Next 
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IV. Import Items 

A. Compound Objects  

 

5. To the right of the Directory Name blank, choose Browse. Navigate to and select the 

folder for the compound object’s digital files. Select the folder, Okay, and then Next 

6. For display image settings, choose “Yes” to Create Display Image and Auto-generate 

display images. Then, Next (see Figure 17) 

 

 
 Figure 17. 

7. On the next screen, choose how you want your file name to be displayed on the web 

site (see Figure 18, page 28): 

a. Use file names as titles. This will be successful if you labeled your items with a 

predetermined and concise file-naming schema (SEE GUIDE on folder 

hierarchy). 

*Also, select to Ignore information before underscore if you named files with 

this option 

b. Label pages using sequence: useful for page-numbered compound objects. Is 

not the best choice for items with covers, title pages and other pages 

occurring before what logically would be labeled “Page 1.” 

8. Select Generate transcripts using OCR if you have an OCR license. Select No 

transcripts if you do not have an OCR license and do not need to create text 

transcripts. 

9. Select Next (See Figure 18)  
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IV. Import Items 

A. Compound Objects  

 

 
  Figure 18. Select how to name the compound object’s pages. Then, 

Next 

 

10. A summary of settings for the imported item will appear. Select Finish (see Figure 19) 

        
Figure 19. Imported item summary report                                Figure 20. Summary report 

  

11. A summary report will appear, confirming the import. Select Close (see Figure 20) 
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IV. Import Items 

A. Compound Objects 

 

12. You can continue to import compound objects by clicking Add and restart the above 

steps or select Finish to import a single compound object (see Figure 21). 

 

 
          Figure 21. 

13. The item(s) will now be viewable in the project spreadsheet 

14. The item will now be viewable for editing in the project spreadsheet 
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IV. Import Items 

B. Single Items 

 

Note: Adding items as single items at an item-by-item rate is the least efficient way to enter 

items into the Project Client, but useful if only one item needs to be imported. 

 

1. From the open Project Screen, choose Add Item (See Figure 14).   

2. To the right of the File Name blank, choose Browse 

3. Navigate to and select the file saved on your computer 

4. Select Open  

5. For display image settings, always choose Create Display Image and Auto-generate 

display image 

6. Select Add 

 
           Figure 22. The Add Item Wizard where steps 1-6 of importing a single 

item are completed 

 

7. Close the Summary  

8. The item will now be viewable for editing in the project spreadsheet 
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IV. Import Items 

 

C. Multiple Items 

  

Adding multiple items is like adding multiple single items in one efficient batch. When using 

this function, contributors specify the directory and the Project Client adds all files from that 

directory to the project spreadsheet. For example, all items in a folder would be added in, 

regardless of file type. 

 

1. Choose Add Multiple Items (See Figure 14)  

2. Select Import From a Directory (this is the default value) 

3. To the right of the Directory Name blank, choose Browse. Navigate to and select 

the folder from your computer. Every item in the selected folder will be imported. 

Click Okay. Then, select Next 

4. For display image settings, choose Yes to create a display image and Auto-

generate display images 

5. Select Next 

 
    Figure 23. Steps 4-5 of importing multiple items 

 

6. Confirm the summary of settings for import by clicking Add items 

7. Close the Summary 

8. The item will now be viewable for editing in the project spreadsheet 
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V. Edit Metadata 

 

There are two possible views for looking at and editing metadata. You can use the project 

screen spreadsheet view (Figure 24), which is the default view with a thumbnail for all 

imported items and has the metadata fields listed from the left to the right, or on an item 

level in the item editing tab (Figure 25). This guide explains how to add and edit metadata in 

both views.   

 

    
Figure 24. Project screen spreadsheet view                   Figure 25. Item editing tab  

 

To view an item individually in the item editing tab, double click on the item’s thumbnail 

image. This individual item view is the best option to view a compound object (all pages are 

displayed) and edit a compound object’s metadata (see Figure 26).  

 
Figure 26. An example of a compound object in the project screen spreadsheet view opened 

up in the item editing tab 
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V. Edit Metadata 

A. Project Spreadsheet View 

 

The Project Spreadsheet displays after items have been imported to the Project Client. Once 

an item is imported to the project, it will appear as a row in the spreadsheet along with all 

other previously imported metadata. You can enter metadata directly into the cells.  

 

How to edit metadata in the Project Spreadsheet: 

1. An item’s metadata can be edited in the Project Screen spreadsheet view by left-

clicking in any white metadata cell. The blank cell will highlight in blue. Type in 

metadata. 

2. To repeat shared metadata between items, click on the appropriate metadata box, 

enter in the metadata, and select the text by left clicking. Then, right click and select 

fill up, fill down to repeat the metadata in a column (see Figure 27). 

 

 
Figure 27. To enter in shared metadata, highlight the metadata cell to be repeated by left 

clicking. Once highlighted, right click and select from the options to fill up, down, all, or fill a 

compound object.  

 

3. Select Fill compound object to apply the metadata to each page of the compound 

object. 

4. An item’s metadata can also be cut, copied, and pasted into other items’ metadata 

cells (See Figure 27).  
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V. Edit Metadata 

B. Item Editing Tab 

 

Metadata entered under the individual item view (in the item editing tab) must be saved by 

selecting Save in the upper left of the item screen or Close and then selecting Yes to save 

changes. 

 

1. As with the Project Screen spreadsheet view, metadata is added by left-clicking on a 

blank metadata field (which will highlight the field in blue) and typing. 

2. Again, changes made to an item and its metadata must be saved by selecting Save in 

the upper left or right. 

 

 
               Figure 28. Editing in the item editing tab. Save and Close options are highlighted by 

red boxes 

 

Another feature in the Item Editing tab is the option to view the imported image larger than 

the thumbnail view permits. 

 
  Figure 29. Select the View option to see a larger display of an item’s image 
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V. Edit Metadata 

B. Item Editing Tab 

 i. Navigation in the Item Editing Tab 

 

 Once a compound object is opened in the item 

editing tab, there are multiple view options available. 

Explore these to find out what personally works best 

for you. 

 

  

Figure 30. Compound object view options 

 

 

 

While in the item editing tab, select a page to edit by 

left clicking under the compound object level-record. 

Pages can also be deleted (red x) or rearranged 

(green arrows). 

 

Figure 31.  Page 002 has been selected to be edited 

and its metadata would display for editing 

 

 

Metadata must be entered for each page of a compound object. An overall compound object 

metadata summary is listed at the top of the object level-record. Page-level metadata is 

viewable by selecting the specific page (see Figure 32). 

 
Figure 32. The image on the left is the metadata in summation for the Rimstone County High 

1952 Yearbook. The image on the right shows the specific metadata for page 1 (named 

001) of this yearbook. Note: the overall compound object metadata differs from the 

metadata for page “001” which needs to be edited for this example project 
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V. Edit Metadata 

C. Supplemental Metadata Information  

 

When working with adding in and editing metadata, please note the following information:  

 

By clicking on the checkbox to the left 

of an item’s thumbnail image, you can 

choose to:  1) Select all the items  

2)Upload the item for approval (the 

final step of working with an item in 

the Project Client), 3) Open the item in 

the item editing tab, or 43) Delete the 

item. 

 

                Figure 33. Item options in the Project Screen 

Spreadsheet View 

 

While working in the Project Spreadsheet and item editing tab, a red exclamation point or 

triangular yellow exclamation point may appear. Hover the mouse over the warning for 

information. In the example below, the title field is blank. The metadata field values of title, 

creator, subject, description, and date original are required metadata fields. 

 

 

Figure 34. Items that have blank required metadata fields are flagged by a red icon until 

metadata is entered. 

 

A yellow warning triangle appears for all metadata that contains a spelling error. Take these 

warnings with a grain of salt. Local vocabulary such as Wibaux, Meagher, Ekalaka, Pend 

d’Oreille, Knievel, and Marias all prompted the yellow warning sign. If this occurs, confirm 

the spelling is correct and continue on.  

 

 
Figure 35.  Examples of spelling error notifications 
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VI. Upload Items for Approval 

 

Once an item has been imported into the Project Client and its metadata is correctly 

entered, it can be uploaded for approval in CONTENTdm Administration. There are no 

restrictions on the number of items that can be uploaded at a time though the time to 

upload is proportional with the number of items uploaded. 

 

1. Choose Select All in the spreadsheet view to upload all items or (see Figure 33) 

2. Selecting items individually by clicking the check box to the left of the item’s 

thumbnail image and 

3. Click upload for approval  

 
                                                   Figure 36. Ways to begin uploading items for approval 

 

4. All of the items in the spreadsheet will disappear  

5. View the Upload Manager (lower left of the screen) to see the progress of your upload  

 
                   Figure 37. View the status of uploading items with the Upload Manager 

 

6. Open up CONTENTdm Administration          

  
                                   Figure 38. How to open up CONTENTdm Administration 
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VII. Editing a Collection That Has Been Previously Approved and Indexed  

 

Once a collection has gone through CONTENTdm’s Project Client and Administration, there 

are two options to edit or change a collection. These edits and changes include: 

 Delete an item 

 Edit metadata 

 Change the structure of an item (the page order) 

 

Examples of what this feature allows: 

 All metadata can be edited 

 Transcripts can be manually entered or edited (in the transcript metadata field) 

 A compound object’s ordering can be rearranged (in the item editing view only) 

 

Steps to pulling an item back into the Project Client (from CONTENTdm Administration): 

 

1) Open up the Project Client 

2) Open the specific project where the item to be edited was created (via the Project tab 

> Open) 

3) In the Project Spreadsheet view, click Find in Collection on the upper toolbar 

4) Search for the item by using either the search bar to the left, the advanced search 

option, or by viewing all items with the browse collection option. 

5) Once you have located the item(s), place a checkmark next to the item’s thumbnail 

view and then click on "Add to Project (edit)" (see figure below) 

6) All selected files will now be available for editing under the project spreadsheet view 

or item editing tab. 

7) Make necessary edits 

8) Upload for approval 

9) Contact the MMP administrator and request approval. 
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VII. Editing a Collection That Has Been Previously Approved and Indexed 

A. Editing via the Project Client  

 

 

From the top to the bottom of the screen, please notice: 

Project collection: The tab entitled “School photographs” is the project’s name. The project  

must be opened in order to do a search.  

 

Find in collection (in red frame): there is a search bar to the left where an item could be  

searched for. This option must be selected to locate the item. Other search options are  

available afterwards. These include: 

 Search: has a search bar to the left for keyword searches 

 Advanced Search: can search by metadata fields 

 Browse collection: brings up all items in the collection 

 

The checkmark: items to be edited must be selected with a checkmark and then chosen to 

Add to Project (follow black arrow).  
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IX. Resources and Contact Information 

 

CONTENTDM USER SUPPORT CENTER 

 

Please navigate to the User Support Center: http://www.contentdm.org/USC. The User 

Support Center is full of free forums, guides, and online trainings to guide you as you work in 

the CONTENTdm software. 

Everyone should have their own user name and password. Sign up by using the organization 

ID of MTSL1034. 

 

Where to find help:  

 Search feature  

 Training & Events tab  

 Knowledgebase tab  

 All Tutorials  

 All Help Files Version 6 
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Montana Memory Project: Contributing Institution Agreement   

(Your institution)___________________________agrees to the following as a Contributing 

Institution of the Montana Memory Project (hereinafter referred to as “MMP”): 

 To read and comply with the MMP Guidelines prior to beginning digitization and the 

creation of  metadata 

 To read and observe the MMP Collection Policy Scope and Purpose 

 To submit a completed MMP Project Planning Document for each new collection the 

Contributing Institution wishes to create in the MMP, for review by the MMP Steering 

Committee  

 To keep new collections unpublished until at least 1 image and related metadata has 

been added. 

 To make its MMP content available at the Collection level and/or Item level in 

WorldCat, through the CONTENTdm Digital Gateway tool or Connexion Digital Import  

 To ensure that URLs to images remain functional, wherever metadata in the MMP 

points to content residing on a server other than the MMP hosted site 

 To commit to the long-term preservation and accessibility of digital master files by 

either a) depositing digital master files that correspond to access files in the MMP in 

the statewide OCLC Digital Archive subscription or b) developing and maintaining an 

appropriate long-term preservation solution in-house for digital master files. 

 To contribute to the ongoing growth and success of the MMP through such efforts as 

local web-page links to MMP collections, assisting new institutions, continuing to 

contribute content, sharing technical expertise and promoting the statewide nature of 

the collection 

 

MMP Mission Statement:  The Montana Memory Project encourages cooperation between 

Montana's cultural institutions and its citizens in order to bring both historic and 

contemporary resources to the digital age. 

 

Signature 

 

 

Institution Name 

 

 

Date 

 

 


